
Liant Software Corporation 

Relativity 
 
 
 
 
 
 
 

Designer Installation Guide 
Second Edition 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

®



 
Copyright © 1994-2008 by Liant Software Corporation.  All rights reserved.  Printed in U.S.A. 

No part of this publication may be reproduced, stored in a retrieval system or transmitted, in any form or by any means, 
electronic, mechanical, photocopied, recorded, or otherwise, without prior written permission of Liant Software 
Corporation. 

The software described in this document is furnished under license and may be copied (with inclusion of the copyright 
notice) only in accordance with the terms of such license. 

The information in this document is subject to change without prior notice.  Liant Software Corporation assumes no 
responsibility for any errors that may appear in this document. 

Companies, names, and data used in examples herein are fictitious. 

Liant Software Corporation 
5914 West Courtyard Dr., Suite 100 

Austin, TX 78730-4911 
U.S.A. 

Phone (512) 343-1010 
 (800) 762-6265 
Fax (512) 343-9487 

 
Web site http://www.liant.com/ 

 

 

 

RM, RM/COBOL, RM/COBOL-85, Relativity, Enterprise CodeBench, RM/InfoExpress, RM/Panels, VanGui Interface 
Builder, CodeWatch, CodeBridge, Cobol-WOW, WOW Extensions, InstantSQL, Xcentrisity, XML Extensions, Liant, and 
the Liant logo are trademarks or registered trademarks of Liant Software Liant Software Corporation. 

Micro Focus COBOL is a registered trademark of Micro Focus International Limited. 

Microsoft, MS, MS-DOS, Windows 98, Windows Me, Windows NT, Windows 2000, Windows XP, Windows Server 
2003, Windows Vista, Windows Server 2008, and Visual Basic are trademarks or registered trademarks of Microsoft 
Corporation in the USA and other countries. 

Simba is a registered trademark of Simba Technologies. 

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company 
Ltd. 

All other products, brand, or trade names used in this publication are the trademarks or registered trademarks of their 
respective trademark holders, and are used only for explanation purposes. 

 
 

http://www.liant.com/


 
Documentation Release History for the Relativity Designer Installation Guide: 

Document Edition Number Applies To Product Version Publication Date 

Second Relativity version 12 and later October 2008 

First Relativity version 6 and later January 2005 

Important  These Liant manuals are distributed as Adobe Acrobat PDF files and require the Adobe Acrobat Reader,  
v6.0 or higher, in order to view them.  The installation program for the Adobe Acrobat Reader is available from the 
Adobe web site at:  www.adobe.com. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.adobe.com/


 
 
 
 
 
 
 
 
 
 
 



 Relativity Designer Installation Guide v 
 Second Edition 

Contents 
 

Preface...................................................................................................... 1 
Introducing the Relativity Designer ...........................................................................................1 
Related Relativity Documentation .............................................................................................2 

Using Online Help ..............................................................................................................3 
Conventions Used in this Document..........................................................................................4 
Registration................................................................................................................................5 
Technical Support ......................................................................................................................5 

Support Guidelines .............................................................................................................5 
Test Cases ...........................................................................................................................6 

Chapter 1:  Installation ............................................................................ 7 
System Requirements.................................................................................................................7 
Installing the Relativity Designer ..............................................................................................8 

Electronic Software Delivery Installation...........................................................................8 
CD-ROM Installation .......................................................................................................10 

Removing the Relativity Designer ...........................................................................................11 

Chapter 2:  Verification.......................................................................... 13 
Prerequisites.............................................................................................................................13 
Starting the Relativity Designer...............................................................................................14 
Opening a Data Source ............................................................................................................15 
Displaying the Table Form ......................................................................................................16 
Viewing COBOL Data.............................................................................................................18 
Closing the Data Source...........................................................................................................19 
Exiting the Relativity Designer................................................................................................19 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



vi Relativity Designer Installation Guide 
 Second Edition 

 
 



Introducing the Relativity Designer 
Preface 

 Relativity Designer Installation Guide 1 
 Second Edition 

Preface 

Introducing the Relativity Designer 
The Relativity Designer is an interactive, Windows-based development tool that enables the 
COBOL application developer to create a relational database view of data stored in existing 
COBOL files.  The Relativity Designer is used in all configurations of Relativity:  the  
single-tier Relativity Data Manager, which resides on a 32-bit Windows-based system, and 
the two-tier Relativity Client/Server, which provides access to COBOL data that resides on  
a server system. 

The Relativity Designer provides the following functions: 

• Automatically extracts the definitions of data files from the COBOL source programs. 

• Collects information regarding the data from the application developer pertaining to the 
correct interpretation of the data file structure. 

• Allows the developer to define and maintain a relational database system of “tables” 
using the COBOL data.  All this information is stored in a catalog. 

This manual, the Relativity Designer Installation Guide, which is part of the Relativity 
document set listed in Related Relativity Documentation (on page 2), describes how to install 
the Relativity Designer software component and verify that the installation was successful.  
The Relativity Designer installation instructions are the same, regardless of whether a non-
client/server configuration (referenced throughout this documentation as “single-tier”) or 
client/server configuration of Relativity is being installed.  However, the Relativity Designer 
verification instructions do differ depending on whether a single-tier or client/server 
configuration of Relativity is being installed.  See Prerequisites (on page 13). 

In addition, your Relativity package contains the document, The Theory of Relativity, A 
Primer, which defines specific terminology and provides a comprehensive overview of the 
Relativity software tools and their functions.  Before you install this Relativity product, be 
sure to read this book. 
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Related Relativity Documentation 
In addition to the Relativity Designer Installation Guide and The Theory of Relativity, A 
Primer, the complete Relativity documentation set consists of the following items: 

• Relativity Client/Server Installation Guide.  A document (one for UNIX and one for 
Windows) that is intended for a System Administrator.  It describes the following: 

− How to install the Relativity Data Server software component on a computer running 
either a UNIX or Windows operating system and verify that the installation was 
successful. 

− How to: 

• Install the Relativity Data Client software component on a secure Windows 
workstation (such as the workstation belonging to a Database Administrator) for 
the purpose of catalog development. 

• Install the Relativity Server Administrator utility program in order define a 
server for the client and configure a server data source. 

• Verify communications between the client and the server. 

− How to install the Relativity Data Client software component on an end user’s 
Windows workstation and verify that the installation was successful by configuring a 
client data source and associating it with a server data source. 

− How to run the RM/COBOL Indexed File Recovery utility (recover1) to recover an 
RM/COBOL indexed file. 

• Relativity Data Client for UNIX Installation Guide.  A document that describes how 
to install and verify the Relativity Data Client software component on a UNIX-based 
server or workstation.  It also describes the utilities for creating client and server data 
sources. 

• UNIX Driver Managers Build Guides.  A pair of HTML documents, located in the 
UDrvMan directory of the Relativity Data Client for UNIX Electronic Software Delivery 
download file and on the Relativity Data Server product CD, that give instructions on 
how to build the two ODBC Driver Managers for UNIX (unixODBC and iODBC) on the 
various UNIX platforms that the Relativity Data Client for UNIX supports.  Note that 
these documents should be referenced only if you decide to rebuild the Liant-supplied 
versions of these Driver Managers. 

• Relativity Data Manager Installation Guide.  A document that describes how to install 
the Relativity Data Manager software component on a Windows-based workstation and 
verify that the installation was successful. 

• Relativity DBA Installation Guide.  A document that describes how to install the 
Relativity DBA (Database Administrator) software component on a Windows-based 
workstation and verify that the installation was successful. 

• Relativity Java Client User’s Guide.  An HTML document, located in the JDBC 
directory of the Relativity Java Client Electronic Software Delivery download file and on 
the Relativity product CD, that describes the installation and verification of the Relativity 
Java Client as well as information about deploying it with Java applications and applets, 
and setting up data source connections.  The Java Client is a Java Database Connectivity 
(JDBC) component that resides in a Java runtime environment (JRE). 
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• Relativity Online Help.  An online HTML help documentation system that provides fast 
access to detailed information on Relativity features and options.  The help system also 
contains step-by-step presentations on how to accomplish specific tasks with Relativity 
and an extensive glossary.  A separate help file is provided for each of the various 
Relativity tools:  the DBMS (Data Client and Data Manager), the Designer, the DBA, the 
Relativity Configuration Utility, and the Server Administrator.  For more details, see 
Using Online Help (on page 3). 

• Relativity README Files.  A set of online HTML documents that lists any changes to 
the Relativity documentation since its publication and contains new technical information 
that supplements the documentation. 

• LiantInstall Program User’s Reference.  A document that describes how to configure 
and control the installations of Liant products, including Relativity. 

Using Online Help 
The Relativity Designer comes with extensive online assistance and step-by-step instructions.  
You can access DSN Help while using Relativity in a number of ways.  The method you use 
often depends on the type of information for which you are searching. 

• Help Contents.  In the Relativity Designer main window, from the Help menu, click 
Contents to open the Relativity Designer online HTML Help system.  The left side of the 
Help window (the navigational pane) contains the Contents, Index, Search, and 
Favorites tabs.  The right side of the Help window (the topic pane) displays the currently 
selected Help topic.  Across the top of the Help window is a group of buttons that help 
you navigate through the Help contents and perform other operations, such as printing a 
topic in the Help file. 

− To browse through topics grouped by subject:  Click the Contents tab.  From 
here, you can go directly to more specific information and a list of all the Help topics 
by double-clicking any closed book icon.  Then select the topic of interest from the 
expanded list and click the topic.  The Help window for that topic appears in the 
topic pane. 

− To see a list of alphabetized index entries (or keywords):  Click the Index tab to 
find specific topics listed alphabetically (the online index is arranged just like a book 
index).  Type an entry or the first few letters of the word you want to search for, or 
scroll through the list.  Then select the topic and click the Display command button.  
The content of the Help topic opens in the Help window. 

− To search for words or phrases that may be contained in a Help topic:  Click the 
Search tab.  Follow the instructions on your screen to complete this task. 

− To create a list of preferred Help topics:  Click the Favorites tab.  Follow the 
instructions on your screen to complete this task.  Note that, by default, the contents 
of this tab is empty until you select topics to populate it.  The content of the 
Favorites tab is automatically saved between sessions. 

• Context-sensitive Help.  While you are working in Relativity, you also can press F1 to 
access the associated Help topic for currently selected menu commands, toolbar buttons, 
dialog box options, and other screen elements. 
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• Tool tips.  When you pause with the pointer (without the mouse button pressed) over an 
item on a toolbar, a small pop-up window that includes a brief description is displayed. 

• Help button in a dialog box.  If available, click the Help button in the dialog box you 
are using.  A Help topic explaining the dialog box appears. 

You can exit Relativity online Help from the Help window by clicking the Close button on 
the title bar or double-clicking the Control Menu icon at the left end of the title bar.  To exit 
a context-sensitive Help window, if necessary, press the Esc key on the keyboard. 

From the Relativity Designer Help menu, you can also access additional online Help files: 

• Click DBMS Help File for information on using the Relativity Data Manager. 

• Click Server Admin Help File for information on using the Relativity Server 
Administrator. 

• Click Relativity Configuration Help for information on using the Relativity 
Configuration Utility to set options that apply to all Relativity data sources. 

Conventions Used in this Document 
This document contains visual cues to help the reader identify important information. 

Table Convention Indicates 

Initial Capitals Menu names, command names, and dialog box, window, and form 
titles. 

Bold Menu, command, and button names. 
Other elements to be selected or typed to accomplish an action. 
Label on input media used during installation. 

Italic Reference to a topic in the current document or another Relativity 
document. 
Reference to another document. 
Emphasis. 

Bold Italic Variables. 

 

 

 

 

 

 

 

 

 

 

 



Registration 
Preface 

 Relativity Designer Installation Guide 5 
 Second Edition 

Registration 
Please take a moment and register your Liant product online at:  http://www.liant.com. 

Registering your product entitles you to the following benefits: 

• Customer support.  Free 30-day telephone support, including direct access to support 
personnel and 24-hour message service. 

• Special upgrades.  Free media updates and upgrades within 60 days of purchase. 

• Product information.  Notification of upgrades or revisions to Relativity when they are 
released. 

You can also receive up-to-date information about Liant and all its products via our web site.  
Check back often for updated content. 

Technical Support 
Liant Software Corporation is dedicated to helping you achieve the highest possible 
performance from the Liant family of products.  The technical support staff is committed to 
providing you prompt and professional service when you have problems or questions about 
your Liant products. 

Technical support services are subject to Liant’s prices, terms, and conditions in place at the 
time the service is requested. 

While it is not possible to maintain and support specific releases of all software indefinitely, 
we offer priority support for the most current release of each product.  For customers who 
elect not to upgrade to the most current release of the products, support is provided on a 
limited basis, as time and resources allow. 

Support Guidelines 
When you need assistance, you can expedite your call by having the following information 
available for the technical support representative: 

• Company name and contact information. 

• Liant product serial number (found in the Electronic Software Delivery email, on the 
media label, or in the product banner message). 

• Liant product version number. 

• Operating system and version number. 

• Hardware, related equipment, and terminal type. 

• Exact message appearing on screen. 

• Concise explanation of the problem and process involved when the problem occurred. 

http://www.liant.com/
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Test Cases 
You may be asked for an example (test case) of the source that demonstrates the problem. 

• The smaller the test case is, the faster we will be able to isolate the cause of the problem. 

• Do not send full applications. 

• Reduce the test case to the smallest possible combination of components required to 
reproduce the problem. 

• If you have very large data files, write a small program to read in your current data files 
and to create new data files with as few records as necessary to reproduce the problem. 

• Test the test case before sending it to us to ensure that you have included all the 
necessary components to run the test case. 

When submitting your test case, please include the following items: 

1. README text file that explains the problems.  This file must include information 
regarding the hardware, operating system, and versions of all relevant software (including 
the operating system and all Liant products).  It must also include step-by-step 
instructions to reproduce the behavior. 

2. Program source files.  We require source for any program that is called during the 
course of the test case.  Be sure to include any copy files necessary for recompilation. 

3. Data files required by the programs.  These files should be as small as possible to 
reproduce the problem described in the test case. 
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Chapter 1:  Installation 

This chapter lists the system requirements and describes how to install the Relativity Designer 
software program on a Microsoft Windows operating system.  The installation procedure is 
the same regardless of whether a client/server or single-tier configuration of Relativity is 
being installed.  Procedures for removing the Relativity Designer (see page 11), if necessary, 
are also provided. 

System Requirements 
Installation of the Relativity Designer on a Windows-based workstation for application 
development requires the following minimum software and hardware. 

Component Requirement 

Computer An IBM PC or compatible machine with a Pentium-class processor or 
higher. 

Operating System Microsoft Windows 2000, Windows XP, Windows Server 2003, 
Windows Vista, or Windows Server 2008. 

Memory 64 MB is recommended. 

Disk Space A hard drive with at least 11 MB of free disk space. 

Installation Media Internet access and/or one CD-ROM drive and one 3.5” diskette drive. 

Monitor 800 x 600 resolution is required.  Higher resolution is recommended. 

Internet Browser A browser (for example, Mozilla Firefox or Microsoft Internet Explorer) 
capable of viewing HTML files, such as the README text or other 
documents that are available in this format. 

Adobe Reader This software, available free from Adobe.com, allows you to view (and 
print) the Portable Document Format (PDF) documents. 

Note  Relativity no longer supports earlier Microsoft Windows versions, including  
Microsoft Windows 98, Microsoft Windows 98 SE, Microsoft Windows Me, and Microsoft 
Windows NT 4.0. 
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Installing the Relativity Designer 
Note  If you have a previous version of Relativity installed, you should remove it prior to 
installing a newer version.  See Removing the Relativity Designer (on page 11). 

The Relativity Designer can be installed on a Windows workstation by using either of the 
following methods: 

• Electronic Software Delivery Installation (as described below) 

• CD-ROM Installation (see page 10) 

You may also automate the installation program for the Relativity Designer, which allows the 
installation of the Designer to be incorporated with the installation of your application.  For 
more information, navigate to www.liant.com/docs.html, and refer to the “Relativity Designer 
Installation Details” section of the LiantInstall Program User's Reference documentation. 

To verify that the installation is successful, see Chapter 2:  Verification (on page 13). 

Note  The instructions that follow refer to an installation components directory, which is the 
directory to which the deliverable file via electronic software delivery was downloaded and 
decompressed. 

Electronic Software Delivery Installation 
Note  You must have an Internet connection and an Internet browser installed to proceed with 
this method of installation. 

The email containing notification of your Electronic Software Delivery contains an 
attachment, a file named liant.lic.  This file is a license certificate authorizing you to install 
the purchased software.  We recommend that you create a directory on your machine to store 
the license certificates for your Liant products and save the liant.lic attachment to this 
directory with a name that is meaningful to you. 

The Relativity Designer is available as a download from the Liant Electronic Software 
Delivery web site in two formats:  Windows Self-Extracting EXE and ISO CD Image.  From 
the web site, simply follow the download and decompress instructions for the file format 
selected, and then perform the installation instructions for that format, as outlined below. 

• Windows Self-Extracting EXE.  The download format for Windows Self-Extracting 
EXE contains only the Relativity Designer product.  After downloading and 
decompressing the deliverable, and creating the installation components directory from 
the Windows Self-Extracting EXE format, follow these steps to install the Relativity 
Designer software: 

Note  When the Windows Self-Extracting EXE is decompressed and the installation 
components directory is created, the LiantInstall program should start automatically.  If 
this is the case, proceed to step 6.  Otherwise, begin with step 1. 

1. Place a copy of your Relativity Designer license certificate, liant.lic, in the directory 
containing the installation components. 

2. Click Start, and then click Run.  In the Run dialog box, click the Browse button. 

3. In the Browse dialog box, navigate to the directory containing the installation 
components. 

4. Click on the file, LiantInstall, and then click Open. 

www.liant.com/docs.html
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5. In the Run dialog box, click OK. 

6. The LiantInstall program begins executing.  Follow the instructions presented on 
the screen and press the Next button to advance through the various pages. 

7. On the Software License Agreement page, you must click “I accept the terms in the 
license agreement” in order to continue with the installation. 

8. On the License Certificates page, the license certificate file for the product being 
installed is displayed.  Do one of the following: 

• If the license certificate for the Relativity Designer software being installed is 
present in the list area, press the Next button. 

• If the license certificate for the Relativity Designer software being installed is 
not present in the list area: 

a. Press the Add button. 

b. In the Select License Certificates dialog box, navigate to the directory 
containing the license certificate file for the Relativity Designer software 
being installed and select the filename for the license certificate.  (This 
license file, named liant.lic, is attached to the original electronic software 
delivery email for the product.) 

c. Press the Open button and then press Next. 

9. On the Installation Type page, do one of the following: 

• Select the “Standard Installation” option to install all the components of all the 
license certificates listed on the License Certificates page immediately, using 
their default settings.  Press the Install button. 

• Select the “Custom Installation” option to select specific components (for those 
products with multiple components) of all the license certificates listed on the 
License Certificates page, and install them, changing their default installation 
settings, as necessary. 

Follow the custom installation instructions presented on the remaining pages.  
On the Ready to Begin Installations page, press the Install button. 

When the installation for the Relativity Designer program starts, follow the 
additional instructions presented by the installation program. 

10. When either the standard or custom installation is complete, click the Finished 
button on the Installation Status page. 

• ISO CD Image.  The download format for ISO CD Image contains the full Relativity 
product CD, including the Relativity Designer and the other Relativity products.  Use  
CD-ROM Burning software, such as Nero (http://www.nero.com) or Roxio’s Easy CD 
Creator (http://www.roxio.com), to create the physical CD-ROM media and then follow 
the instructions contained in CD-ROM Installation (on page 10) to install your product. 
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CD-ROM Installation 
After downloading and decompressing the deliverables, and creating the installation 
components directory from the ISO CD Image format, follow these steps to install the 
Relativity Designer software from the CD-ROM: 

1. Insert the product CD in the appropriate CD-ROM drive. 

2. Do one of the following: 

• If the installation program starts automatically, proceed to Step 3. 

• If the installation program does not start automatically, click Start, and then click 
Run.  In the Open text box of the Run dialog box, type the following: 

d:LiantInstall 

where, d is the drive letter of the CD-ROM drive.  Click OK. 

3. The LiantInstall program begins executing.  Follow the instructions presented on the 
screen and press the Next button to advance through the various pages. 

4. On the Software License Agreement page, you must click “I accept the terms in the 
license agreement” in order to continue with the installation. 

5. On the License Certificates page, the license certificate file for the product being installed 
is displayed.  Do one of the following: 

• If the license certificate for the Relativity Designer software being installed is 
present in the list area, press the Next button. 

• If license certificates for any products you do not wish to install are present in the list 
area, select them and press the Remove button.  Then, press the Next button. 

• If the license certificate for the Relativity Designer software being installed is not 
present in the list area: 

a. Press the Add button 

b. In the Select License Certificates dialog box, navigate to the directory 
containing the license certificate file for the Relativity Designer and select the 
filename for the license certificate. 

This license file, usually named liant.lic, is included on the license diskette that 
came as part of the installation media. 

• Press the Open button and then press Next. 

Note  The liant.lic license certificate file can be copied from the diskette to a 
location on a hard drive and that location can be specified during installation.  We 
recommend that you create a separate directory on your machine to store the license 
certificate files for all your Liant products and save those files with a name that is 
meaningful to you. 

• If there are license certificates for any other products that you wish to install at this 
time, press the Add button again to add them; otherwise, press the Next button. 
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6. On the Installation Type page, do one of the following: 

• Select the “Standard Installation” option to install all the components of all the 
license certificates listed on the License Certificates page immediately, using their 
default settings.  Press the Install button. 

• Select the “Custom Installation” option to select specific components (for those 
products with multiple components) of all the license certificates listed on the 
License Certificates page, and install them, changing their default installation 
settings, as necessary. 

Follow the custom installation instructions presented on the remaining pages.  On the 
Ready to Begin Installations page, press the Install button. 

When the installation for the Relativity Designer program starts, follow the 
additional instructions presented by the installation program. 

7. When either the standard or custom installation is complete, click the Finished button on 
the Installation Status page. 

Removing the Relativity Designer 
The Relativity Designer can be removed from the Windows workstation on which it was 
installed.  This may be necessary if the Relativity Designer is to be moved to a different 
machine or if a new release of the Relativity Designer is to be installed on the same machine. 

Removing an existing version of the Relativity Designer prior to installing a new one ensures 
accurate use counts on shared files and enables all files to be properly removed during a later 
uninstall process. 

To remove the Relativity Designer: 

1. Open the Windows Control Panel. 

2. In the Control Panel, do one of the following: 

• On Windows 2000, XP, or Server 2003, double-click Add or Remove Programs. 

• On Windows Vista or Server 2008, double-click Programs and Features. 

3. In either the Add or Remove Programs window or the Programs and Features window, 
select Liant Relativity vx Designer from the list of currently installed programs and 
updates.  (vx is the version number of the product to be removed.) 

4. Do one of the following to start the uninstall process: 

• On Windows 2000, XP, or Server 2003, click the Remove button. 

• On Windows Vista or Server 2008, click the Uninstall button. 

5. In the message box, click Yes to proceed with the uninstall process. 

6. The Liant Relativity vx Designer dialog box is then displayed, detailing the progress of 
the uninstall. 

When the uninstall is successfully completed, click OK. 

7. Click OK to close either the Add or Remove Programs window or the Programs and 
Features window. 

8. Close the Windows Control Panel. 
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Chapter 2:  Verification 

This chapter describes how to verify the installation of the Relativity Designer software on a 
Windows-based workstation.  The verification takes place with a catalog that was installed 
during the installation of the Relativity Data Manager or Relativity Data Server, and a data 
source named Verify that was created during the verification of the installation of the 
Relativity Data Manager or Relativity Data Server and Data Client products. 

In addition, the Relativity Designer software includes three sample databases called Shirt-1, 
Shirt-2, and Shirt-3.  These three databases contain COBOL data files, COBOL source 
programs, and COBOL schema (or RST) files.  The Shirt-3 sample also contains a Relativity 
database catalog for the COBOL data files.  The Shirt-3 database has its ownership assigned 
to the DB3 Owner group with a password of 1234.  The sample files are provided for both 
RM/COBOL and Micro Focus COBOL, and are used in conjunction with Liant Relativity 
training.  However, they may also be used as a convenient database to experiment with the 
Relativity Designer. 

Prerequisites 
This verification process assumes the following: 

• If you are using the client/server version of Relativity, that you have followed the 
instructions in the Relativity Client/Server Installation Guide (for either UNIX or 
Windows, as appropriate) to install a Relativity Data Server, set up a server data source 
named Verify, install a Relativity Data Client on the same machine as the Relativity 
Designer, and set up a client data source that is also named Verify and associate it with 
the server data source, Verify. 

• If you are using the single-tier (that is, non-client/server) version of Relativity, that you 
have installed a Relativity Data Manager on the same machine as the Relativity Designer 
and followed the instructions in the Relativity Data Manager Installation Guide for 
setting up a data source named Verify. 
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Starting the Relativity Designer 
To start the Relativity Designer in Windows: 

1. Click Start, point to Programs, point to Liant, point to Relativity vx (where vx is the 
version number of the product), and then click Designer. 

The Welcome to Relativity window is displayed and you are ready to open the Verify 
data source. 

 

Note  The Welcome to Relativity window appears when you first install and start the 
Relativity Designer.  From this window, you can set up and create a new data source, or 
open an existing or recently used Relativity data source.  After completing the first 
session with Relativity, the most recently used data source is always selected by default 
in this window when you start Relativity again.  To disable the Welcome to Relativity 
window after the initial installation, clear the Show Welcome at Startup check box.  
Subsequently, when you start another Relativity session, you will begin all operations in 
the Relativity Designer main window.  You may, however, enable this capability again 
by choosing Welcome from the Tools menu. 

2. If you wish, click Cancel to dismiss the Welcome to Relativity window. 
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Opening a Data Source 
To open the Verify data source: 

1. In the Relativity Designer main window, on the File menu, click Open Data Source. 

The Open Relativity Data Source dialog box opens. 

 

Alternatively, if the Welcome to Relativity window remains displayed, click either the 
Recent or Existing option, select the Verify data source from the list, and then click OK.  
Proceed to Step 3. 

2. In the Data Source Name box, select Verify.  If necessary, click the Down Arrow to 
display a list of data source names. 

3. Click Open. 

The Logon dialog box opens to collect information needed in order to authenticate your 
access to the server. 

 

4. In the Logon dialog box, type a user name in the appropriate box and click OK.  
(Because security has not been set up to access the Verify data source, any user name will 
suffice and no password is required.) 
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The Catalog window for the selected data source, Verify, is displayed in the Relativity 
Designer main window. 

 

Displaying the Table Form 
1. On the Catalog window, click Tables in the Catalog Objects area. 
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2. Double-click the table name BackOrder. 

The Table form for the BackOrder table opens. 
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Viewing COBOL Data 
1. Click the Show Table Contents button on the Table form toolbar.  The contents of the 

data items in the Table form are displayed in the Show Table Contents form. 

 

2. Click the Close button to exit the Show Table Contents form. 
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Closing the Data Source 
To close a data source, do one of the following: 

• On the File menu, click Close Data Source.  Shortcut:  Ctrl+D. 

• In the Catalog window, click Close in the upper-right corner of the title bar. 

When you close a data source, the Relativity Designer main window remains open, allowing 
you to reopen the data source, open another data source, or exit the Relativity Designer. 

Exiting the Relativity Designer 
To exit the Relativity Designer, do one of the following: 

• On the File menu, click Exit.  Shortcut:  Ctrl+F4. 

• In the Relativity Designer main window, click Close in the upper-right corner of the title 
bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Exiting the Relativity Designer 
Chapter 2:  Verification 

20 Relativity Designer Installation Guide 
 Second Edition 

 

 

 

 

 

 

 

 

 

 


	Relativity Designer Installation Guide, Second Edition
	Copyright
	Document Release History
	Comments
	Preface
	Introducing the Relativity Designer
	Related Relativity Documentation
	Using Online Help

	Conventions Used in this Document
	Registration
	Technical Support
	Support Guidelines
	Test Cases


	Chapter 1:  Installation
	System Requirements
	Installing the Relativity Designer
	Electronic Software Delivery Installation
	CD-ROM Installation

	Removing the Relativity Designer

	Chapter 2:  Verification
	Prerequisites
	Starting the Relativity Designer
	Opening a Data Source
	Displaying the Table Form
	Viewing COBOL Data
	Closing the Data Source
	Exiting the Relativity Designer



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




